


Copyright © 2000–2004 ESRI
All Rights Reserved.
Printed in the United States of America.

The information contained in this document is the exclusive property of ESRI.  This work is protected under United States copyright law
and other international copyright treaties and conventions.  No part of this work may be reproduced or transmitted in any form or by
any means, electronic or mechanical, including photocopying or recording, or by any information storage or retrieval system, except as
expressly permitted in writing by ESRI.  All requests should be sent to Attention: Contracts Manager, ESRI, 380 New York Street,
Redlands, CA 92373-8100, USA.

The information contained in this document is subject to change without notice.

U. S. GOVERNMENT RESTRICTED/LIMITED RIGHTS
Any software, documentation, and/or data delivered hereunder is subject to the terms of the License Agreement.  In no event shall the
U.S. Government acquire greater than RESTRICTED/LIMITED RIGHTS.  At a minimum, use, duplication, or disclosure by the U.S.
Government is subject to restrictions as set forth in FAR §52.227-14 Alternates I, II, and III (JUN 1987); FAR §52.227-19 (JUN 1987)
and/or FAR §12.211/12.212 (Commercial Technical Data/Computer Software); and DFARS §252.227-7015 (NOV 1995) (Technical
Data) and/or DFARS §227.7202 (Computer Software), as applicable.  Contractor/Manufacturer is ESRI, 380 New York Street,
Redlands, CA 92373-8100, USA.

ArcExplorer, ArcIMS, ArcSDE, ESRI, Geography Network, the ArcExplorer logo, the ArcGIS logo, GIS by ESRI, the Geography Network
logo, www.esri.com, and www.geographynetwork.com are trademarks, registered trademarks, or service marks of ESRI in the United
States, the European Community, or certain other jurisdictions.

Microsoft and the Windows logo are registered trademarks and the Microsoft Internet Explorer logo is a trademark of Microsoft
Corporation.  Other companies and products mentioned herein are trademarks or registered trademarks of their respective trademark
owners.



iii

Contents 1   Welcome to  ArcExplorer—Java Edition     1
What you can do with ArcExplorer      2
Installing ArcExplorer     3
How to get help      12

2   Adding data layers      13
Adding shapefiles      14
Adding images      15
Working with images     16
Adding ArcSDE layers      17
Viewing data in an ArcIMS Service     18
Viewing data on the Geography Network     19

3   Properties of the legend, overview map, and scalebar     21
Using the legend     22
Adding an overview map     24
Working with the scalebar     25

4   Symbolizing layers     27
Getting general information about a layer     28
Setting a layer’s scale factors     29
Drawing features with one symbol     30
Drawing features with graduated symbols     31
Drawing features with unique symbols     32
Adding labels to a map     33
Adding shields to line features     34



iv USING ARCEXPLORER—JAVA EDITION

12
5   Getting and using the attributes of features     35

Identifying  features     36
Finding features     37
Searching for features     38
Building a query expression      39
Selecting features     40
Buffering features     41
Displaying Map Tips     42
Measuring distances     43

6   Address matching     45
Locating an address     46

7   Printing, copying, and saving     47
Printing a map     48
Copying a map to a file     49
Saving a project     50



IN THIS CHAPTER

1

Welcome to
ArcExplorer—Java Edition

• What you can do
with ArcExplorer

• Installing ArcExplorer

• How to get help

Welcome to ArcExplorerTM—JavaTM Edition, a geographic data explorer
developed by ESRI. You can use ArcExplorer to view and query geographic
data stored on your computer or on the Web.

ArcExplorer offers tools for viewing and querying your spatial and attribute
data; performing spatial analysis tasks, such as selecting and buffering
features; creating a variety of maps, such as unique and graduated symbols;
and much more. You’ll be amazed at the ease with which you can take
advantage of these tools.

1
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What you can do with ArcExplorer

Using ArcExplorer, you can:

• Pan and zoom the map’s extent.

• Query spatial and attribute data.

• Create a buffer around selected features.

• Measure distances on your map.

• Create one symbol, unique symbols, and graduated symbols maps.

• Label map features with many options for effects.

• Locate an address.

• View data from the Geography NetworkSM.

ArcExplorer also features legends, overview maps, saving and retrieving projects, and map printing.

Scalebar

Overview Map

Legend

Toolbar

Menu Bar
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What you need to install ArcExplorer

ArcExplorer can be installed on a Windows 2003, Windows® XP, 
Windows 2000, Windows NT®, or UNIX® operating system.

How to install ArcExplorer on a Windows
operating system

Installing the software

To begin installation, navigate to AEJavaSetup.exe. This file is
located on the ArcIMS® installation CD or the directory where
you downloaded it from the Web.

Double-click  AEJavaSetup.exe and follow the onscreen
instructions.

Starting ArcExplorer

After installation, click Start > Programs > ArcGIS >
ArcExplorer to open ArcExplorer.

Installing ArcExplorer

How to install ArcExplorer on a Solaris operating
system

Installing the software from the ArcIMS CD

SolarisTM  includes Volume ManagementTM software, which
automatically mounts and provides immediate access to your
CD–ROM. When using Volume Management software, place the
ArcIMS CD into your CD drive. At this point, the ArcIMS disk is
mounted. Type the following command:

% cd /cdrom/cdrom0/ArcExplorer

Note: For security reasons, don’t install ArcExplorer as root.

Make sure that the user account that will install ArcExplorer has
write permissions to the installation directory.

The “install” command has four options:

Usage:  install  <-help | -load | -remove | -verify>

Type “install -help” to read more about the installation procedure.

To start the ArcExplorer installation, type the following command
from anywhere on your system:

%/cdrom/cdrom0/ArcExplorer/install -load

This starts the dialog box for the menu-driven ArcExplorer
software installation. Default selections are noted in brackets, [ ].
To obtain a list of options or Help, type “?” at any prompt. You
can quit the installation procedure at any time by typing “quit” or
“q”. To return to a previous question, type the caret, “^”.

Installing the software from the Web download

After downloading the ArcExplorer.tar.Z file, move it to the
directory where you wish to install ArcExplorer.  Use the
uncompress command:

%uncompress ArcExplorer.tar.Z
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Then use the tar command:

%tar xvf ArcExplorer.tar

The “install” command has four options:

Usage:  install  <-help | -load | -remove | -verify>

Type “install -help” to read more about the installation procedure.

To start the ArcExplorer installation, type the following command in the directory where you downloaded the files on your system:

%./install -load

This starts the dialog box for the ArcExplorer software installation procedure, which is menu driven. Default selections are noted in
brackets [ ]. To obtain a list of options or Help, type “?” at any prompt. You can quit the installation procedure at any time by typing
“quit” or “q”. To return to a previous question, type the caret, “^”.

Setting up your account

ESRI recommends that you execute ArcExplorer from a C shell. The following instructions are for a C shell environment setup.

To use ArcExplorer, add the following lines to your .login or .cshrc file:

setenv AEJHOME <ArcExplorer Installation Directory>/aej90exe

setenv LD_LIBRARY_PATH $AEJHOME/lib

Make sure that $AEJHOME/bin is in the PATH.

set path = ( $path $AEJHOME/bin )

To enable the changes, type:

% source <.login or .cshrc>

Editing the $HOME/aimsclient.properties file

Update the value of the WebBrowser key in the aimsclient.properties file to point to the location of your default browser.

Update the value of the AEJavaHelp key in the aimsclient.properties file to point to the location of the ArcExplorer online Help files.

Starting ArcExplorer

With  $AEJHOME/bin included in your PATH, start ArcExplorer by typing:

aejava
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How to install ArcExplorer on a Linux operating system

Installing the software from the ArcIMS CD

Red Hat Linux automatically mounts and provides immediate access to your CD–ROM. Place the ArcIMS CD into your CD drive and
type the following command:

% cd /mnt/cdrom/ArcExplorer

Note: For security reasons, don’t install ArcExplorer as root.

Make sure that the user’s account that will install ArcExplorer has write permissions to the installation directory.

The “install” command has four options:

Usage: install <-help | -load | -remove | -verify>

Type “install -help” to read more about the installation procedure.

To start the ArcExplorer installation, type the following command from anywhere on your system:

%/mnt/cdrom/ArcExplorer/install -load

This starts the dialog box for the menu-driven ArcExplorer software installation. Default selections are noted in brackets, [ ]. To obtain a
list of options or Help, type “?” at any prompt. You can quit the installation procedure at any time by typing “quit” or “q”. To return to a
previous question, type the caret, “^”.

Installing the software from the Web download

After downloading the ArcExplorer.tar.Z file, move it to the directory where you wish to install ArcExplorer. Use the uncompress
command:

%uncompress ArcExplorer.tar.Z

Then use the tar command:

%tar xvf ArcExplorer.tar

The “install” command has four options:

Usage: install <-help | -load | -remove | -verify>

Type “install -help” to read more about the installation procedure.
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To start the ArcExplorer installation, type the following command in the directory where you downloaded the files on your system:

%./install -load

This starts the dialog box for the ArcExplorer software installation procedure, which is menu driven. Default selections are noted in
brackets [ ]. To obtain a list of options or Help, type “?” at any prompt. You can quit the installation procedure at any time by typing
“quit” or “q”. To return to a previous question, type the caret, “^”.

Setting up your account

ESRI recommends that you execute ArcExplorer from a C shell. The following instructions are for a C shell environment setup.

To use ArcExplorer, add the following lines to your .login or .cshrc file:

setenv AEJHOME <ArcExplorer Installation Directory>/aej90exe

setenv LD_LIBRARY_PATH $AEJHOME/lib

Make sure that $AEJHOME/bin is in the PATH.

set path = ( $path $AEJHOME/bin )

To enable the changes, type:

% source <.login or .cshrc>

Editing the $HOME/aimsclient.properties file

Update the value of the WebBrowser key in the aimsclient.properties file to point to the location of your default browser.

Update the value of the AEJavaHelp key in the aimsclient.properties file to point to the location of the ArcExplorer online Help files.

Starting ArcExplorer

With $AEJHOME/bin included in your PATH, start ArcExplorer by typing:

aejava
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How to install ArcExplorer on IBM AIX operating system

Installing the software from the ArcIMS CD

To install ArcExplorer from the CD, become super user and put the ArcIMS CD into your CD–ROM drive; type:

% su

You will be prompted for your super user password. If you do not know this password, contact your system administrator. If a /cdrom
directory does not exist, create one:

# mkdir /cdrom

Now mount the ArcIMS CD:

# mount -v 'cdrfs' -r'' -p'' /dev/cd0/cdrom

where dev stands for the CD–ROM device. (or use smit).

At this point, the ArcIMS CD is mounted. Before installing ArcExplorer, exit super user mode:

# exit

Note: For security reasons, don’t install ArcExplorer as root.

Make sure that the user’s account that will install ArcExplorer has write permissions to the installation directory.

The “install” command has four options:

Usage: install <-help | -load | -remove | -verify>

Type “install -help” to read more about the installation procedure.

To start the ArcExplorer installation, type the following command from anywhere on your system:

% /cdrom/ArcExplorer/install -load

This starts the dialog box for the menu-driven ArcExplorer software installation. Default selections are noted in brackets, [ ]. To obtain a
list of options or Help, type “?” at any prompt. You can quit the installation procedure at any time by typing “quit” or “q”. To return to a
previous question, type the caret, “^”.

After you’ve finished installing ArcExplorer, take the ArcIMS CD out of the CD–ROM drive by unmounting it.

As super user, type:

# umount /dev/cd0

where dev stands for the CD–ROM device.
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Installing the software from the Web download

After downloading the ArcExplorer.tar.Z file, move it to the directory where you wish to install ArcExplorer.  Use the uncompress
command:

% uncompress ArcExplorer.tar.Z

Then use the tar command:

% tar xvf ArcExplorer.tar

The “install” command has four options:

Usage:  install  <-help | -load | -remove | -verify>

Type “install -help” to read more about the installation procedure.

To start the ArcExplorer installation, type the following command in the directory where you downloaded the files on your system:

% ./install -load

This starts the dialog box for the ArcExplorer software installation procedure, which is menu driven. Default selections are noted in
brackets [ ]. To obtain a list of options or Help, type “?” at any prompt. You can quit the installation procedure at any time by typing
“quit” or “q”. To return to a previous question, type the caret, “^”.

Setting up your account

ESRI recommends that you execute ArcExplorer from a C shell. The following instructions are for a C shell environment setup.

To use ArcExplorer, add the following lines to your .login or .cshrc file:

setenv AEJHOME <ArcExplorer Installation Directory>/aej90exe

setenv LIBPATH $AEJHOME/lib

Make sure that $AEJHOME/bin is in the PATH.

set path = ( $path $AEJHOME/bin )

To enable the changes, type:

% source <.login or .cshrc>

Editing the $HOME/aimsclient.properties file

Update the value of the WebBrowser key in the aimsclient.properties file to point to the location of your default browser.

Update the value of the AEJavaHelp key in the aimsclient.properties file to point to the location of the ArcExplorer online Help files.
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How to install ArcExplorer on an HP-UX operating system

Installing the software from the ArcIMS CD

To install ArcExplorer from the CD, become super user and put the ArcIMS CD into your CD–ROM drive; type:

% su

You are prompted for the super user password. If you do not know this password, contact your system administrator. If a /cdrom
directory doesn’t exist, create one:

# mkdir /cdrom

Now mount the ArcIMS CD:

# mount -F cdfs /<dev> /cdrom

Where <dev> stands for the CD–ROM device.

At this point, the ArcIMS CD is mounted. Before installing ArcExplorer, exit super user mode:

# exit

Note: For security reasons, don’t install ArcExplorer as root.

Make sure that the user account that will install ArcExplorer has write permissions to the installation directory.

The “install” command has four options:

Usage: install <-help | -load | -remove | -verify>

Type “install -help” to read more about the installation procedure.

To start the ArcExplorer installation, type the following command from anywhere on your system:

%/cdrom/ArcExplorer/install -load

This starts the dialog box for the menu-driven ArcExplorer software installation. Default selections are noted in brackets, [ ]. To obtain a
list of options or Help, type “?” at any prompt. You can quit the installation procedure at any time by typing “quit” or “q”. To return to a
previous question, type the caret, “^”.

Starting ArcExplorer

With  $AEJHOME/bin included in your PATH, start ArcExplorer by typing:

aejava
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Installing the software from the Web download

After downloading the ArcExplorer.tar.Z file, move it to the directory where you wish to install ArcExplorer. Use the uncompress
command:

%uncompress ArcExplorer.tar.Z

Then use the tar command:

%tar xvf ArcExplorer.tar

%cd ArcExplorer

The “install” command has four options:

Usage: install <-help | -load | -remove | -verify >

Type “install -help” to read more about the installation procedure.

To start the ArcExplorer installation, type the following command in the directory where you downloaded the files on your system:

%./install -load

This starts the dialog box for the ArcExplorer software installation procedure, which is menu driven. Default selections are noted in
brackets [ ]. To obtain a list of options or Help, type “?” at any prompt. You can quit the installation procedure at any time by typing
“quit” or “q”. To return to a previous question, type the caret, “^”.

Setting up your account

ESRI recommends that you execute ArcExplorer from a C shell. The following instructions are for a C shell environment setup.

To use ArcExplorer, add the following lines to your .login or .cshrc file:

setenv AEJHOME <ArcExplorer Installation Directory>/aej90exe

setenv SHLIB_PATH $AEJHOME/lib

Make sure that $AEJHOME/bin is in the PATH.

set path = ( $path $AEJHOME/bin )

To enable the changes, type:

% source <.login or .cshrc>
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Editing the $HOME/aimsclient.properties file

Update the value of the WebBrowser key in the aimsclient.properties file to point to the location of your default browser.

Update the value of the AEJavaHelp key in the aimsclient.properties file to point to the location of the ArcExplorer online Help files.

Starting ArcExplorer

With $AEJHOME/bin included in your PATH, start ArcExplorer by typing:

aejava
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How to get help

ArcExplorer provides several ways for you to get help. In
addition to this book, you can use ArcExplorer Help and ESRI on
the Web to answer your questions.

Getting online help

If you need more information about a specific option or
procedure, use ArcExplorer Help.

Click the Help menu and click Help Contents to open ArcExplorer
Help.

Message Console messages

When ArcExplorer encounters an error with data or an operation,
most often a message is posted in the status bar of the main
window.

All messages generated by ArcExplorer are posted to the
ArcExplorer Message Console. You can open the Message
Console by clicking the Help menu and clicking ArcExplorer
Message Console.

The message level in the Message Console is set by clicking the
View menu, clicking Message Level, and pointing to one of the
choices.

You can click the File menu and click Save As to save the
messages to a text file.

Visit ESRI on the Web

ESRI home page

ESRI’s home page at www.esri.com has up-to-date information on
ESRI® software and services.

ArcExplorer home page

The ArcExplorer home page at www.esri.com/arcexplorer has

• The latest information about ArcExplorer

• Current frequently asked questions (FAQs)

Be sure to check this site often for all the latest information on
ArcExplorer.
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Adding data layers

• Adding shapefiles

• Adding images

• Working with images

• Adding ArcSDE layers

• Viewing data in an ArcIMS Service

• Viewing data on the Geography
Network

2
This chapter shows you how to add data layers to ArcExplorer.

The key functionality of ArcExplorer is the viewing of spatial data. This
chapter shows you how to view data that is stored on your computer or
published as an ArcIMS service. You can also view data on the Geography
Network. An ArcIMS Service allows the content of a map configuration file to
be published on the Internet by registering it to the ArcIMS Spatial Server and
Web server.

Data from local sources or the Internet, an ArcSDE® server, or an ArcIMS
Service can be added to ArcExplorer.
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Adding
shapefiles
You can add shapefiles to
ArcExplorer with the Catalog.
The Catalog is opened with the
Add Layers button.

1. Click the Add Layers button
to open the Catalog.

2. Navigate to the folder that
contains shapefiles.

3. Click a file to add.

4. Click the Add Layers button.

Repeat steps 3 and 4 to add
more shapefiles.

5. Click the Close button to
close the Catalog.

Add Layers

Tip

Refreshing the Catalog
Right-click Local and click Refresh
to see an updated listing of folders
and mapped drives. Right-click a
folder and click Refresh to see an
updated listing of files.

Tip

Shapefiles with duplicate
field names are not allowed
Shapefiles that contain duplicate
field names cannot be drawn in
ArcExplorer and thus are not listed
in the Catalog.

Adding Favorites
Favorites is a list of shortcuts to
commonly used folders. Right-click
a folder in the Catalog and click
Add to Favorites.

Tip

3

5

4

2

1
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Adding images
You can work with images in
ArcExplorer by displaying them
as a background layer in your
map configuration file.

See the next pages for details
on working with images and
supported image formats.

You can set a transparency
value on an image using the
Layer Properties dialog box. See
Chapter 4, ‘Symbolizing
Layers’, for more details.

Adding a single image

1. Click the Add Layers button
to open the Catalog.

2. Click the File Type dropdown
list and choose Image Files.

3. Navigate to the folder that
contains an image.

4. Click an image to add.

5. Click the Add Layers button.

Repeat steps 4 and 5 to add
more images.

6. Click the Close button to
close the Catalog.

Adding an Image
Directory

In the Catalog:

1. Click the File Type dropdown
and choose Image Files.

2. Navigate to the folder that
contains more than
one image.

3. Click the *ImageDirectory
entry in the Catalog.

4. Click the Add Layers button.

All the images in that folder
are added.

5. Click the Close button to
close the Catalog.

3

5

2

Add Layers

4

2

4

1

3

5

6

1

Tip

Image Directory
If a folder contains more than one
image, it is an Image Directory. In
the Catalog, the top entry of an
Image Directory will be
*ImageDirectory. Selecting this
entry adds all of the images in the
directory to ArcExplorer.



16 USING ARCEXPLORER—JAVA

You can work with images in ArcExplorer by displaying them as a
background layer in your map configuration file.

You can add JPEG, TIF, GIF, BMP, or PNG files to  ArcExplorer.

World files are required

A world file contains parameters to transform raster rows and
columns into real-world coordinates.

Many image formats require world files. ArcExplorer requires that
the world file must use a three-letter extension, and it can’t have
scientific notation.

Displaying an ArcIMS Image Directory

An ArcIMS Image Directory is simply a directory containing
several image files. When you choose the Image Directory from
the catalog window, all images are added to the map.

Setting image transparency

Making an image transparent allows you to view overlapping
images in a single map. You can set the transparency of an image
or ImageService with the Layer Properties dialog box. From the
Layer Properties dialog box, click the General tab to set a
transparency value.

Working with images
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Adding ArcSDE
layers
ArcExplorer allows you to use
ArcSDE and ArcSDE for
Coverages layers once you’ve
added an ArcSDE connection.

Type port:<port number> in the
Instance input box. If necessary,
your ArcSDE administrator will
provide you with the ArcSDE
instance information. The
instance should be listed in
your system’s Services file.

Consult your ArcSDE adminis-
trator if you are not sure if your
system is set up to connect to
an ArcSDE database.

Connecting to ArcSDE

1. Click the Add Layers button
to open the Catalog.

2. Double-click ArcSDE.

3. Double-click Add ArcSDE
Connection.

4. Type the name of the Server.

5. Type port:<port number> for
the ArcSDE instance.

6. If necessary, type a Database
name.

7. Type your User name and
Password.

8. Click Test Connection
(optional). If the connection
succeeds, continue. If the
connection fails, use the
error message to correct the
failure.

9. Click OK to connect.

The ArcSDE database is now
listed in the Catalog.

Adding ArcSDE layers

10.Click a layer to add.

11.Click the Add Layers button.

Repeat steps 10 and 11 to
add more layers.

12.Click the Close button to
close the Catalog.

9

Add Layers

2

W

E

3

Q

4

5
6

7

8

Tip

Disconnecting from
ArcSDE
Disconnect from an ArcSDE
database by right-clicking the
ArcSDE server in the left panel of
the Catalog and clicking Discon-
nect.

Tip

Connection errors
If your connection to ArcSDE
failed, you can use the Message
Console to see detailed error
messages. To open the ArcExplorer
Message Console, click the Help
menu and click Message Console.

1
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Viewing data in
an ArcIMS
Service
An ArcIMS Spatial Server can
serve a Feature Service or an
Image Service. You can use
ArcExplorer to view an ArcIMS
Service.

A Feature Service uses the
Spatial Server’s feature stream-
ing capabilities. The server
bundles data and streams it to
the requesting client. Requests
are sent to the server only when
additional data is needed.

Image Services use the Spatial
Server image rendering capabili-
ties. When a request is re-
ceived, a map is generated on
the server, and the response is
sent back as an image. A new
map image is generated each
time a client requests new
information.

Typing a Service name on the
WWW Connection dialog box
is optional. If you do not
specify a Service name, you will
be connected to all the Ser-
vices.

1. Click the Add Layers button
to open the Catalog.

2. Double-click the WWW icon.

3. Double-click Add Web Site to
open the WWW Connection
dialog box.

4. Type the hostname.

5. Click OK to connect.

The Web site’s ArcIMS
Services appear in your
catalog.

6. Click a Service.

7. Click a layer in the Feature
Service or the Image Service
to add.

8. Click the Add Layers button.

Repeat steps 6 and 7 to add
more layers.

9. Click the Close button to
close the Catalog.

Add Layers

9

Tip

List of Services
You must disconnect and reconnect
from the Spatial Server to see an
updated list of Services. Right-click
on the machine name, click
Remove, then connect again.

8

2
3

6

5

4

7

1
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Viewing data on
the Geography
Network
The Geography Network is a
global network of geographic
information. It provides the
infrastructure needed to
facilitate the sharing of geo-
graphic information between
data providers, service provid-
ers, and users around the world.
You can use ArcExplorer to
access the Geography Network
and discover a wide variety of
geographic content.

You can click the Geography
Network button to open a Web
browser to the Geography
Network. Once you have found
data, you can click Add to
ArcExplorer to add that data to
ArcExplorer. Saving the project
will allow you to save a
reference to the data on the
Geography Network.

Learn more about the Geogra-
phy Network at
www.geographynetwork.com.

1. Click the Geography Network
button to open a Web
browser to the Geography
Network.

2. Use the Geography Network
Explorer to find data.

3. Click Add to ArcExplorer to
add that data to the
ArcExplorer map and legend.

4. Close the Web browser.

The data from the Geography
Network is now listed in the
legend.

Geography Network

2

4

3

See Also

See Chapter 4, ‘Symbolizing
Layers’, for details on how to set
the transparency of an Image
Service.

1
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Properties of the legend,
overview map, and scalebar

• Using the legend

• Adding an overview map

• Working with the scalebar

This chapter introduces the ArcExplorer interface. You will learn how to set
up and use the legend, overview map, and scalebar.

Terms used throughout this book in referring to the interface are defined in
this chapter.

3
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Using the legend
All layers in a map are listed to
the left of the map in the legend.
The legend shows the layer name
and the symbol used to draw
each layer. The check box next to
each layer indicates whether it is
currently turned on or off in the
map, that is, whether it is
currently drawn on the map or
not.

The order in which the layers are
listed in the legend is also
important. The layers at the top
of the legend are drawn on top of
those below it. Layers that form
the background of your map are
listed at the bottom of the
legend. To change the order a
layer is drawn in, drag the layer
up or down in the legend. The
Move Layer choice on a layer’s
right-click menu gives options
for moving the layer.

You can change the width of the
legend by dragging the border
between the legend and the map
either left or right. This is useful
if you want to increase the width
of the legend so that you can see
long layer names.

You can turn the legend off by
clicking the View menu and
unchecking the Legend choice.

Click the check box to
the left of each layer’s
name to make the layer
draw in the map.
Clicking again will turn
the layer off.

Make a layer active by
clicking on its name in the
legend. Many operations
work only on active layers.
When a layer is active, it
appears raised in the
legend.

Use these arrows
to  resize the width
of the legend.
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Double-click a layer to
open the Layer
Properties dialog box.

Right-click a layer to
open a menu of choices
for the layer.
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Adding an
overview map
The overview map displays the
full or partial extent of a layer
with a red box outlining the
current extent of the map. A full
or partial extent is displayed
depending on how far you have
zoomed in.

Opening an overview
map

1. Click the View menu and
check Overview Map to add
an overview map panel.

Adding a layer to the
overview map

1. Right-click on a layer listed in
the legend and click Use in
Overview Map.

To remove the layer, repeat
step 1 to uncheck Use in
Overview Map.

1

1

Tip

Using the overview map
when zoomed in
Zooming in very close to a feature
will result in a zoomed in map that
may not have a red outline.
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Working with the
scalebar
Each time you zoom in, zoom
out, or resize the map, the scale
changes. These changes are
reported on the scalebar.

The scalebar consists of a
representative fraction (RF)
(1:24,000), a ruler with distance
markers, and an equation (one
inch = 40 miles). The fraction
(RF scale) is a common way to
present scale in cartography
and can be read as “one inch on
the screen is equal to
24,000 inches on the ground.”
The equation (sometimes
referred to as a “verbal scale”)
presents the same information
but translates the single unit
(an inch in this example) into a
unit you’d use when getting
around in the real world (e.g.,
miles).

Adding a scalebar

1. Click the View menu and
click Scale Bar.

Setting scalebar
properties

1. Click the View menu and
click Scale Bar Properties.

2. Point to Map Units, Scale
Units, and Screen Units to set
the appropriate units.

1

2

1

Map units

Map units are the units in which geographic
data is stored (data source units). You can set
the map units as decimal degrees, feet, or
meters.

Scale units

Scale units display in the scalebar itself and in
the right side of the verbal scale equation
(1 centimeter = 200 kilometers). You can set
the scale units as miles, feet, meters, or
kilometers.

Screen units

Screen units correspond to the actual display
on your computer monitor and are presented
on the left side of the verbal scale equation—
for example, 1 inch = 40 miles. You can set the
screen units as either inches or centimeters.

Tip

Right-click the scalebar to
set properties
You can also right-click the scalebar
to open the Scale Bar Properties
menu.
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Symbolizing layers 4
• Getting general information about

a layer

• Setting a layer’s scale factors

• Drawing features with one symbol

• Drawing features with graduated
symbols

• Drawing features with unique
symbols

• Adding labels to a map

• Adding shields to line features

You can communicate complex geographic information more effectively using
maps than with tables or lists because maps take advantage of our natural
abilities to distinguish and interpret colors, patterns, and spatial relationships.
When you display your data on a map, you’ll see distributions, relationships,
and trends that you couldn’t see before.

Choosing how to represent your data on a map may well be your most
important mapmaking decision. Symbolizing your data involves choosing colors
and styles that will represent features. It also involves grouping or classifying
features according to their attribute values.

This chapter shows you how to create attractive maps and use symbolization
as a powerful tool for exploring, understanding, and analyzing your data.
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7

Getting general
information about
a layer
How a layer is displayed can be
changed using the Layer
Properties dialog box.

The General tab allows you to
change the name of the layer as
it appears in the legend and
provides information about the
datafile.

The General tab can also be
used to set a scale factor for a
layer.

For images and Image Services,
use the General tab to set a
transparency value. Setting the
transparency allows two
overlapping images or Image
Services to be viewed in one
map.

1. Click a layer in the legend to
make it active.

2. Click the Layer Properties
button.

3. Click the General tab.

4. Type a new name in the
Layer Name box to change
the layer’s name.

5. Click the Only show layer in
the following scale range
button to set scale factors.

6. Type a scale to never show
the layer above or below.

7. Click OK to close the dialog
box and see the changes.

4

Layer Properties

3

See Also

See the next section, ‘Setting a
layer’s scale factors’,  for more
details on setting scale factors.

2

5
6
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Setting a layer’s
scale factors
You can control the scale at
which a layer displays by
setting its scale threshold. For
example, you could set a state
boundaries layer to turn off
after you zoom past a certain
point and set the county
boundaries to turn on at the
same scale. Setting up scale
factors can help keep the map
display clean and focused on
relevant data.

When a scale factor has been
set on a layer, the layer will not
appear in the legend once you
go outside the specified scale
range.

Adding scale factors

1. Use the zoom tools to set an
extent for your display.

2. Right-click the layer’s name
and click Scale Factors.

3. Click Set Minimum Scale
Factor if you want the layer to
turn off if you zoom in any
closer.

4. Click Set Maximum Scale
Factor if you want the layer to
turn off if you zoom further
out.

Removing scale factors

1. Right-click the layer’s name,
click Scale Factors, and point
to Remove Scale Factors.

The map will refresh to show
the layer.

2

1

Tip

Setting scale factors on the
General tab
You can also set scale factors on
the General tab of the Layer
Properties dialog box.

4
3
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6

1. Click a layer in the legend to
make it active.

2. Click the Layer Properties
button.

3. Click the Style box to apply a
new style to the layer.

4. Click the Color box to choose
a color.

5. Click the Size box to apply a
new size to the layer.

6. Click OK to close the dialog
box and see the changes.

Drawing features
with one symbol
The One Symbol classification
displays all the features in a
layer with the same color and
style. When you add a layer to
ArcExplorer, it is displayed as a
One Symbol map.

Using the Layer Properties
dialog box, you can change the
color, size, or style of the One
Symbol map.

Layer Properties

3
4
5

2
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W

1. Click a layer in the legend to
make it active.

2. Click the Layer Properties
button.

3. Click Graduated Symbols.

4. Click a Field.

5. Click a number of Classes.

6. Click a Style.

7. Click a Start and End Color.

8. Click a Start and End Size.

9. Click an entry in the Symbol
column to change its color.

10.Double-click a value in the
Label column to select it.
Enter a new value.

11.Click OK to close the dialog
box and see the changes.

Drawing features
with graduated
symbols
Using the Graduated Symbols
classification, the range of
attribute values is divided into
equal-sized subranges; the
features are then classified and
displayed based on those
subranges.

You can create a Graduated
Symbols map using the Layer
Properties dialog box. You can
also change the color, size,
style, and quantity of
subranges associated with a
Graduated Symbols map.

Tip

Changing the value’s label
For a Graduated Symbols map,
you can change the label of each
value by typing a new value in the
Label column. Be sure to press
Enter after adding each new value.

3
4
6

8

Layer Properties

Q

5

9

7

2
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1. Click a layer in the legend to
make it active.

2. Click the Layer Properties
button.

3. Click Unique Symbols.

4. Click a Field.

5. Click a Color Scheme.

6. Click a Style.

7. Check Remove Outline to
remove the outline on
features.

8. Click an entry in the Symbol
column to change its color.

9. Double-click an entry in the
Label column to select it.
Enter a new label.

10.Click OK to close the dialog
box and see the changes.

Tip

Changing the value’s label
For a Unique Symbols map, you
can change the label of each value
by typing a new value in the Label
column. Be sure to press Enter
after adding each new value.

Drawing features
with unique
symbols
You can create a Unique
Symbols map using the Layer
Properties dialog box.

The Unique Symbols classifica-
tion displays features by
applying a different color to
each unique value for a
specified field.

Layer Properties

9

6
5
4
3

7

8
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Adding labels to a
map
Add labels to features with the
Labels tab of the Layer Proper-
ties dialog box.

The example on this page
shows the label placement
functionality for point features.
Label placement for lines
include above-, on-, or below-
the-line options.

Adding labels

1. Click a layer in the legend to
make it active.

2. Click the Layer Properties
button.

3. Click the Labels tab.

4. Click a field for labels.

5. Click a Font.

6. Click a Size.

7. Check the Bold or Italic
boxes to change the text.

8. Click the Effects button for
more options on changing
the appearance of labels.

9. Click a Color.

10.Click a label Placement.

11.Click an angle of rotation for
the labels.

12.Click OK to close the dialog
box and see the changes.

Adding effects to labels

1. Check Shadow to add a
three-dimensional effect.

2. Check Glow to add a color
around the label.

3. Check Background to add a
colored box under the label.

4. Check Allow Duplicates to
allow all labels to display.

5. Check Use highest text
quality to apply antialiasing.

6. Click OK.

Tip

Using highest text quality
The check box for using the highest
text quality is also referred to as
antialiasing.

When lines are drawn at an angle,
they may appear jagged due to the
number of pixels available to
display them. Antialiasing allows
the line to be smooth by coloring
adjacent pixels in such a way as to
give the edge of the line a more
gradual fade to the background
color.

Clearing labels
You can also clear labels by right-
clicking on a layer in the legend,
clicking Clear, and pointing to
Clear Labels.

Labeling in bold
If you want your labels in bold, use
one of the following fonts for best
text quality: Dialog, Default, Serif,
and Sans Serif.

7

1
2
3
4
5

3
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6
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Tip

Tip

6
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7

Adding shields to
line features
You can add highway shields to
line features using the Labels
tab of the Layer Properties
dialog box.

Adding shields

1. Click a line layer in the
legend to make it active.

2. Click the Layer Properties
button.

3. Click the Labels tab.

4. Click a field for labels.

5. Click a Font.

6. Click a Size.

7. Click a Color.

8. Check the Use Shields box.

9. Click Shields to open the
Shield Properties dialog box.

Using the same shield for all
features

10. Click the Use the same
 shield for all features option.

11. Click a shield type from the
 dropdown list.

Skip to Step 15.

Using different shields

12. Click the Use different
 shields option.

13. Click a Field to specify each
 shield type.

14. Click each Symbol to set the
 shield type for each value.

15. Click OK.

16. Click OK to close the dialog
 box and see the changes.

6

Layer Properties
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5

8
9

Q
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Getting and using the
attributes of features 5
• Identifying features

• Finding features

• Searching for features

• Building a query expression

• Selecting features

• Buffering features

• Displaying Map Tips

• Measuring distances

This chapter describes how to use ArcExplorer to get information about the
features of your data. You can perform queries in ArcExplorer by pointing at
features on a map to identify them (spatial queries) or finding which features
meet certain criteria (attribute queries).
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Identifying
features
Suppose you are looking at a
map of the world and you want
to get information about a
particular city. To get informa-
tion about one of the features
on your map, use the Identify
tool. When you click a feature
with this tool, ArcExplorer
displays the attributes of the
feature in a dialog box.

1. Click a layer in the legend to
make it active.

2. Click the Identify button.

3. Click a feature on the map.

4. The results of the Identify are
shown in the Identify Results
dialog box.

5. If more than one feature is
found, the features are listed
in the Features panel. Click
each feature to see its
Identify results.

6. Close the dialog box when
finished viewing results.

Identify

5

2
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Finding features
You can use the Find tool to
locate particular features from
the layers in your map. Find
works by searching the layer or
layers you specify for features
with the value you specified.
Only fields that have been
defined as text strings, as
opposed to numeric values, are
searched.

To search for features based on
a numeric value, use the Query
Builder tool described in the
‘Building a query expression’
section.

1. Click the Find button.

2. Type any part of a word you
want to find. Do not use
quotes around the search
string.

3. Click the layer or layers you
would like to search.

4. Click Find to execute the
search.

5. Click one of the results in the
right panel to make it active.

6. Click Pan To to pan the view
to the selected feature.

7. Click Zoom To to zoom the
view to the selected feature.

8. Click Close when you are
finished finding features.

Tip

Image Service notation
In the Find dialog box shown on
this page, the Find is performed on
an Image Service. The Image
Service notation shows the name of
the Image Service and the Image
Service’s sublayer separated by a
period. In this example, the Image
Service is named World, and the
sublayer used to find features is
named country.

5

2

3

4

8 6 7

Find1
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Searching for
features
The Search tool is enabled if
you open a project or ArcIMS
Service that has been created
with stored queries.

Once a stored query has been
created, the Search tool allows
you to type only a value to
search for rather than a full
query expression.

1. Click a layer in the legend
that has stored queries to
make it active.

2. Click the Search button.

3. In the Search by list, click the
stored query you would like
to use.

4. The Query Expression is
updated as you click a stored
query.

5. Type a search string.

6. Click Search.

7. Click a result in the lower
panel.

The feature is highlighted on
the map.

8. Click Pan To or Zoom To to
locate the result on the map.

9. Click Close to change the
dialog box.

7

8

Search

See Also

You can create stored queries using
the Author component of ArcIMS.
See ArcIMS Help for more details.

6

3

4

5

9
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Building a query
expression
A query expression is a precise
definition of what you want to
select. Building a query
expression is a powerful way to
select features because an
expression can include multiple
attributes, operators, and
calculations.

Remember to include single
quotes around values in your
expression that are text strings.
If you choose a value from the
Values box, the single quotes
are added for you.

You can generate a simple set of
statistics on a field by clicking
Statistics. On the Select a field
to get statistics dialog box, you
can click the Use Query Results
check box to only calculate
statistics on the selected
records.

The results of a query can be
saved to a text file using the
Save button. In the Save dialog
box, type the name of the file
with a .txt extension.

Tip

Working with query results
The results of a query can be saved
to a comma-delimited text file. The
text file can then be used in another
program, such as Microsoft® Excel,
to create a spreadsheet.

1. Click a layer in the legend to
make it active.

2. Click the Query Builder
button.

3. Click a field to query.

4. Click an operator to be used
in the expression.

5. Click a sample value or type
a value for the expression.

6. Verify that the query expres-
sion is correct.

7. Click Execute to perform the
query.

8. Click a field in the Display
Field dropdown to only show
one field in the panel.

The results appear in the
lower panel.

9. Click to select a value or
values from the query results
panel.

10. Click Highlight to make the
selected feature or features
highlighted on the map.

11. Click Pan or Zoom to pan or
zoom to the selected
features.

12. Click Statistics.

13. Click a field to be used for
statistics and click OK.

 The statistics are shown in a
separate dialog box.

14. Click the Save button to
save the query results to a
text file.

3

6
7

9

Query Builder
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Selecting
features
Use the Graphic Selection
button to select features, then
view their attribute values using
the Attributes button.

The Clear Selection button
clears the selected features in
all layers. To clear the selection
of a particular layer, right-click it
in the legend, click Clear, and
point to Clear Selection.

1. Click a layer in the legend to
make it active.

2. Click the Graphic Selection
button and click either
Rectangle, Circle, Polygon,
or Line.

3. Click and drag to create a
shape for selecting features.

4. Click the Attributes button to
see the values for the
selected feature or features.

If multiple features were
selected, they are listed in
the left panel.

5. Click each feature to see its
attributes.

AttributesGraphic
Selection

Clear Selection

5

2 4
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Buffering features
You can create a buffer around
selected features. Once a buffer
has been applied, you can use
the buffer to select features
from another layer. Selecting
features of one layer with the
features of another layer’s
buffer can be applied to solve
many problems. A project to
widen roads may involve
buffering the road features and
selecting features from a parcels
layer that overlaps the buffer.

The map units must be set in
order to create a buffer. The
map units are the units your
data is stored in. You can set
the map units by clicking the
View menu, clicking Scale Bar
properties, and pointing to Map
Units.

Tip

Check map units if buffer
seems incorrect
If the buffer is generating unex-
pected results, verify that the map
units are set appropriately. You can
set the map units by clicking the
View menu, clicking Scale Bar
Properties, pointing to Map Units,
and clicking the appropriate unit.

1. Click the Buffer button.

2. Type a distance for buffering
the feature.

3. Click miles, meters, kilome-
ters, or feet for the Buffer
Units.

4. Click Apply to see the buffer.

5. Check the box to select
features from another layer.

6. Click a layer to select
features from.

7. Click OK to see the selection
and close the dialog box.

Note: You can view attributes for
any layer on your map,
including the one you’ve
selected features from, with your
buffer. To do this, make the layer
active in the legend.

Buffer1

47
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Displaying Map
Tips
Map Tips are small popups that
display data for a field you
specify.

You can only display one Map
Tip per layer.

Adding Map Tips

1. Click the Map Tips button to
open the Map Tips dialog box.

2. Click a layer for Map Tips.

3. Click the field you would like
to display in the Map Tips.

4. Click Set Map Tips.

5. The Map Tip Field will update
with the field you choose.

Repeat the process for each
layer you would like to
display with Map Tips.

6. Click OK to close the dialog
box and begin using Map
Tips.

Removing Map Tips

Removing Map Tips from
the selected layer

1. Click a layer to select it.

2. Click the Clear Selected Map
Tips Field button.

Removing all Map Tips

3. Click the Clear All Map Tips
Fields button.

4. Click OK to close the dialog
box.

4

3

2

Map Tips

Tip

Clearing Map Tips
You can clear a layer’s Map Tips by
right-clicking on the layer in the
legend, clicking Clear, and pointing
to Clear MapTips.
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Measuring
distances
Use the Measure button to
measure distances on your map.
You can measure distances on
your map in feet (ft), miles (mi),
meters (m), or kilometers (km).

The map units must be set
appropriately in order to get
accurate measure results. The
map units are the units your
data is stored in. By default,
ArcExplorer sets the map units
to decimal degrees.

Measuring a distance

1. Click the Measure button.

2. Point to one of the measure
units.

3. Click and drag a line defining
the distance you would like
to measure.

The segment and total
measurements appear in the
upper left corner of the map.

Clearing the measure
totals

1. Double-click the map to clear
the measure totals and end
measuring.

See Also

See the ‘Working with the scalebar’
section in Chapter 3 to learn more
about setting the map units.

Measure

2

1

Tip

Check map units if
measure results seem
incorrect
If the measure results seem
incorrect, verify that the map units
are set appropriately. You can set
the map units by clicking the View
menu, clicking Scale Bar Proper-
ties, pointing to Map Units, and
clicking the appropriate unit.

Tip

Clearing measure totals
You can clear the measure totals by
clicking the Measure button and
clicking Clear Measure Totals.
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Address matching 6
• Locating an address

Addresses are probably the most commonly used form of geographic data.
Geocoding is the process by which you add point locations defined by street
addresses, or other address information, to your map. It’s the computerized
equivalent of pushing pins into a street map on your wall. Address matching is
a type of geocoding. You can do single record address matching on Image or
Feature Services using ArcExplorer.
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Locating an
address
The Locate Address button
performs an address match: the
locating of a point based on a
text string of address values.

The Locate Address button is
enabled on viewers that have
Services created with geocoding
properties set up.

As more than one layer in a
service could have geocoding
properties set, use the Select
Layer dropdown box to select the
layer you would like to use to
locate an address.

After locating an address, use
the Clear Selection button to
clear the point and label from the
map.

1. Add a layer from an Image or
Feature Service that has
geocoding properties set.

2. Click the Locate Address
button.

3. Click the layer that you would
like to locate an address
from.

4. Type the values of the
address. The more informa-
tion entered, the more
accurate your results will be.

Fields that are required to
perform the address match
appear in red.

5. Click Locate.

6. The results of the address
match appear in the lower
panel. Also, a point and a
label are placed on the map.

7. Click Pan To or Zoom To to
locate the result on the map.

8. Click Close to close the
dialog box.

See Also

You can set an ArcIMS Service’s
geocoding properties using the
Author component of ArcIMS. See
ArcIMS Help for more details.

5

4
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Locate Address

7

2



IN THIS CHAPTER

47

Printing, copying, and
saving 7
• Printing a map

• Copying a map to a file

• Saving a project

You’ve displayed your data in a map. You’ve chosen the symbols you want to
use. This chapter outlines how to print a map; copy your map to an image; and
save your work as a project (.axl file), also referred to as a map configuration
file.
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Printing a map
Use the steps outlined in
Chapter 4, ‘Symbolizing layers’,
of this book to symbolize your
data. Then use the Pan and
Zoom tools so that the display in
the map looks the way you want
it to look on paper.

ArcExplorer provides a simple,
8 1/2" x 11"-size map layout in
landscape (horizontal) format.

1. Click the Print button.

2. If necessary, change the
printer settings.

3. Click OK.

Print

See Also

See the ‘Copying a map to a file’
section in this chapter for details
on how you can save your map
image to a JPEG file. Once the map
is saved as an image, you can use
it to design your own print layouts.

3

2

1
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Copying a map to
a file
Use the steps outlined in
Chapter 4, ‘Symbolizing layers’,
of this book to symbolize your
data. Then use the Pan and
Zoom tools so that the display
in the map looks the way you
want it to look on paper.

You may want to copy the
image of a map for use in
another application.
ArcExplorer makes it easy to
create a graphic image of your
map.

1. Click the Copy Map Image to
File button.

2. Navigate to a folder.

3. Type a name for the image.

4. Click Save.

A JPEG of your map has
been saved to the selected
folder.

2

Copy Map Image to File

3 4

1
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Saving a project
ArcExplorer saves projects in
files with a .axl extension. The
paths to the data, whether
layers are turned on or off, the
map extent, any classification or
labels applied to layers, and any
scale factors you may have set
are saved. When you create a
project or map configuration
file, you’re not changing or
altering the base data in any
way.

1. Click the Save Project button.

2. Navigate to a folder.

3. Type a name for the project.

4. Click Save.

Projects can be opened in
ArcExplorer by clicking the
Open Project button and
using the Open dialog box to
navigate to a project.

Save Project

2

43
Tip

Moving  data
When opening a project,
ArcExplorer will not prompt you
for any data that may have moved
since you last saved the project.
Instead, it will warn you with a
message that the data cannot be
found.

1
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